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Mission Statement 
Fleming College Is Committed To: 

• the continual improvement of access to college property, facilities and services for persons 
with disabilities; 

• the participation of students and staff with disabilities in the development and review of its 
annual accessibility plan; 

• the provision of quality services – both what we deliver and how we deliver services – to all 
members of the college community. 

What is it? 
Creating accessible documents helps all learners by ensuring that they are able to read, hear, and see all 
the information included in a presentation or document. Creating accessible documents includes using 
color contrast appropriately, sans serif fonts such as Verdana and Arial, clear language principles, 
alternate formats, and other methods. 

What are the benefits? 
Accessible documents help make documents easier to read, view, or listen to (using assistive 
technology). Creating accessible documents help everyone, not just those with vision, hearing or 
auditory disabilities. They help make your information more clear, readable, and engaging!  

How do I make my documents accessible? 
Keep your document simple. Follow the steps outlined below. To help anyone who needs to create 
accessible documents in MS Word, Excel, and PowerPoint, contact the Accessibility Facilitator, Human 
Resources department. 

Steps to Create an Accessible Word Document 
1. Text 

• There are hundreds of fonts to choose from when creating documents. However, not all 
fonts are created equal when it comes to accessibility. Generally, sans serif fonts work best 
as screens with low resolution make serif fonts more difficult to discern. 

• In order to ensure that documents will be accessible to the largest audience possible, 
choose one of the following sans serif font styles: Arial, Verdana. 

• No matter which one of the font styles above is chosen, for accessibility it is recommended 
to use a minimum standard font size of 12 point. 

2. An Accessible ‘Text Box’ Alternative 
• Do not use Text Boxes, as they are inaccessible.  A screen reader will not read the contents 

of Text Boxes until it has reached the very end of the document. 
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• To highlight some text as an, ‘Example’, ‘Case Study’, ‘Quotation’ or any of the other 
reasons to build a Text Box into any document, here is an accessible alternative: 
o Highlight the text. 
o Click on ‘Outside Borders’ from the drop down borders menu in the Paragraph area of 

the Ribbon. 
o Choose a fill color for the inside of the box from the ‘Theme Colors’ bucket. (Be careful 

to ensure the contrast level between text and background stays within limits). 
• Since screen readers do not announce the color of text, clues may be included in this box to 

indicate to a person using a screen reader what this text is for, and when it begins and ends. 
Words like ‘Case Study’ at the beginning and ‘End Case Study’ at the end are very beneficial. 
Highlight the text and make it the same color as the Theme Color and no one except the 
screen reading software will see it. Adding this ‘invisible’ text will make the document more 
fully accessible. 

3. Font Styles 
• Using built-in formatting styles could be the single most important step in making 

documents accessible. Built-in formatting styles provide a logical reading order that serves 
as a navigation guide for persons utilizing assistive technologies. 

• Always use styles to format documents. Most importantly, always use styles to create 
Headings and Lists. 

• Choosing a Style 
o Start in the Styles Group (Home Tab, Styles Group): 
o To modify any previewed style, right click it. 
o To preview more styles, select the drop-down icon. 

• Open the Styles Pane for managing and controlling all available styles. To open the Styles 
Pane, select the icon in the bottom right corner of the styles group 

• Use the Styles Pane for managing and controlling multiple styles. 
o To apply a style, select text in the main document and select a style name. To select text 

with a keyboard, place cursor at beginning of text, press and hold Ctrl+Shift and Right or 
Left Arrow to end of the text to highlight. 

o To modify an existing style, right click the style name and then select the drop-down 
icon.  

o To make new styles, inspect and manage existing styles, use the controls in the bottom 
left corner of the Styles Pane. Use Tab Key inside the Style pane if navigating by 
keyboard. 

o To set preferences for how styles are displayed in this window, select the Options 

button. 
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4. List Formatting 
• When bulleted or numbered list formatting is used, screen readers will properly announce 

the text as being part of a list. List formatting provides the user with a means to quickly 
navigate between items as well as move in and out of lists. 

• When lists are made with repeated use of the Tab key or Spacebar, screen readers will not 
recognize them as lists, meaning that the list reading controls are inoperative. 

• Set lists in Word by: Home Tab, Paragraph Group and use the list controls. 
• Navigating by Keyboard - make a list by first highlighting the text then pressing Alt, H, then 

U for Unordered list (bulleted list), N for Numbered list, or M for more options for the list. 
• To indent - Alt, H, then AI for increasing indent, or AO for reducing indent. 

5. Apply Heading Levels in Style Formatting 
• When headings are defined using Word's built-in heading styles, Screen Reader users can 

quickly navigate through the document and can easily skip from heading to heading. 
• When headings are incorrectly marked up, using character formatting only (e.g., applying 

BOLD format, and/or using ALL CAPITAL LETTERS), there is no programmatic way for the 
Screen Reader to know where the headings are in the document. 

• To Apply Headings: 
o Highlight the text to be made into a Heading. To select text with a keyboard, place 

cursor at beginning of text, press and hold Ctrl+Shift and Right or Left Arrow to end of 
text to be highlighted. 

o Open the Styles Pane. 
o Apply the appropriate Heading to the text in the main document. Arrow up or down 

within Styles pane to find appropriate Heading. 
o To modify the heading styles, right click (Shift+F10) the style name. 

Heading Order 

• Assigning headings in documents is the most important accessibility feature that can be 
added to a document. Traveling from heading to heading is the number one way people 
who use Assistive Technologies navigate documents. 

• Headings should be applied to provide a sequential and relational understanding. This 
means that the heading which introduces a big idea, should be identified as a Heading 1 
(read by a screen reader as, ‘Heading, Level 1’). If the next heading still speaks to some 
aspect of the same idea introduced in your Heading 1, then it should be identified as a 
Heading 2 (read as, ‘Heading, Level 2’). The next heading could be another Heading, Level 2, 
a Heading, Level 3, or if a new ‘big idea’ is being introduced a Heading, Level 1. 

• Other rules for Headings: 
o Sequential headings should never be more than one level apart from one another. 

Meaning, you can follow a Heading 2 with either a Heading 1 or a Heading 3, but not a 
Heading 4. 
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o The first Heading in a document should be assigned as a Heading 1. 
o You may have multiple Heading 2s after a Heading 1. This same rule applies to all 

Heading levels. 
o In Word you may assign heading levels down to Heading 9. 

6. Table of Contents 
• In addition to providing a quick and necessary way for persons using Assistive Technologies 

to navigate a document, applying Headings has another excellent benefit for content 
creators and document reviewers. A Table of Contents can be added to a document in four 
easy steps. 
o Place cursor at the desired Table of Contents location 
o Go to References tab 
o Click on Table of Contents 
o Choose a style and click 
o To navigate by Keyboard, Alt, S, T 

• The Table of Contents will include all Headings, show their relationship to each other, and 
they will automatically be ‘hyperlinks’. 

7. Images and Objects 
• Many images, graphics or tables included in documents need to have alternative text and 

captions. Otherwise these items will not be perceived, nor properly understood by persons 
who have visual disabilities. 

• Alternative text and captions are read by screen readers allowing the content and function 
of these images, graphics or tables to be accessible to those with visual or certain cognitive 
disabilities. 

• To add Alt Text in Microsoft Word, Right Click (or, Shift + F10) on the image, click Format 
Picture, choose Alt Text, fill in the Description box. 

• Wrapping Text 
o Lastly, when adding an image or graphic always set the wrapping style to “In Line with 

Text”. Text that wraps around an image or graphic often times will confuse a screen 
reader, making it difficult for the user to understand. 

o Right click the image (or Shift + F10) and select Text Wrapping, then choose In Line with 
Text. 

8. Tables 
• Microsoft Word provides an easy method for creating accessible simple tables. Include a 

description or explanation of the table contents by formatting the table with alternate text. 
• To create a simple table, follow these steps to ensure it is accessible. 

o Select: Insert tab, click on Table menu 
o Select the number of rows and columns by either, a) Using the cursor - start at the top 

of the grid and drag the mouse to include all of the columns and rows wanted. b) By 
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keyboard navigation - Alt, N, T, then use arrows to choose number of rows and columns. 
Press Enter to Insert Table. 

o After a table has been created and populated with data, a Header Row needs to be 
identified to allow the heading text to be distinguished from the data area of the table. 
Identifying a Header row is also important if the table spans more than one page. To 
identify the Header Row: 

o Select the first row of the table, Right click (Shift + F10), for context menu, 
o Table Properties, Row tab 
o Ensure the options “Allow row to break across pages”, and “Repeat as header row at 

the top of each page” are checked. 
o Select OK 

9. Hyperlinks 
• Hyperlink text should provide a clear description of the link destination. One of the ways a 

person who uses Assistive Technologies can navigate a document is by skipping from 
hyperlink to hyperlink, or they can also pull up a list of all the links in a document (Insert + 
F7). Since both of these methods of navigation do not include any of the surrounding text, 
the hyperlink text by itself needs to provide sufficient meaning. 

• For this reason, using phrases like, ‘Click Here’, or ‘Visit’ are not sufficient as they by 
themselves do not provide enough meaning. 

• To add a hyperlink to a document: 
o Place the cursor where the hyperlink is to appear, or simply highlight the text in the 

document that is to become a link. 
o In the Insert tab, click on Hyperlink and a dialog box will open.  
o In the Text to Display box, type in the name or phrase that briefly describes the link 

destination. (If text was highlighted, this box will already be filled) 
o Then choose to enter either a URL, a location within the same document, an email 

address, or even link to another document. 
o If choosing a URL, type it into the Address box. Click OK 

10. Columns 
• Use the Columns feature for placing text in columns. Do not format the text into columns by 

using tabs, because assistive technologies may not be able to recognize them. 

11. Page Numbering 
• Numbering the pages of your document helps those reading and editing your document 

effectively navigate and reference its content. For users of assistive technologies, it can 
provide a valuable point of reference within the document. 

• To insert page numbers: 
o Go to menu item: Insert 
o In the Header & Footer section, select Page Number 
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o Select where you would like to insert your page numbers 

12. Colour 
• Good Contrast 
• People who have low-vision or color-blindness have difficulty reading documents when text 

color does not strongly contrast with the background color. Over 5% of men have partial 
color blindness either having difficulty distinguishing red from green, or distinguishing blue 
from yellow. Choosing poor color combinations can make reading a struggle. 

• Readers with macular degeneration, glaucoma or other eye diseases may have great 
difficulty reading text which is small or which does not contrast strongly with the 
background. Problems with colored text also arise when printing on a black and white 
printer. Not having enough contrast between the foreground and background colors may 
make the words difficult to read. 

• Never Use Color Alone to Convey Important Information 
o Some people have color vision problems which prevents them from distinguishing 

between certain colors. When developing documents using color to distinguish between 
more than one option, always provide a redundant element to allow for understanding. 

• When producing documents ensure that the text and background have a sufficiently high 
level of contrast. Documents with low contrast can be difficult, if not impossible to read for 
people with low vision. It is sometimes difficult just by looking at a document to tell exactly 
the ratio of contrast. 

• Tools are available online that will help determine the exact level of contrast, Contrast 
Checker  is an excellent resource for this purpose. 

13. Check Accessibility 
• Perform a test of the document’s accessibility prior to distributing it either via email or by 

posting it to the internet.  Use a screen reader such as JAWS, NVDA, WindowEyes, etc. 
Preferably, develop an Accessibility Testing team of persons experienced at using Assistive 
Technologies. 

• Microsoft Word also has a built-in accessibility feature. However, do not rely on ‘machine’ 
testing alone to test for accessibility. 

• To access the Accessibility Checker in Microsoft Word: In the File tab, click on Info, Check 
for Issues, and then Check Accessibility.  

Creating Accessible PowerPoint Presentations - Keep it simple 
1. Fonts  

• Be consistent with the fonts used in the document 
• Use a sans serif font, 22-point minimum – such as Arial, Helvetica or Verdana that are large 

enough for both projectors and online viewing 

http://snook.ca/technical/colour_contrast/colour.html#fg=33FF33,bg=333333
http://snook.ca/technical/colour_contrast/colour.html#fg=33FF33,bg=333333
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• Avoid using text shadow or glow effects for any text as they may not be accessible by screen 
readers 

• Avoid using italics or upper-case letters for emphasis 

2. Colours  
• Use appropriate colour contrast (e.g. black and white) 

• Avoid using solid dark colour backgrounds 

• Make sure that all information conveyed with colour can also be conveyed without colour 

• For print documents use a matte/non-glossy finish 

3. Spacing  
• Avoid putting a lot of information on a slide as it can be confusing and unreadable 

• Follow the rule of thumb - four lines per slide 

4. Images  
• Set wrapping style of non-text elements as “In line with text” 

• Add alternative text to graphics and images 

5. Check Accessibility 
• Perform a test of the document’s accessibility prior to distributing it either via email or by 

posting it to the internet.  Use a screen reader such as JAWS, NVDA, WindowEyes, etc. 
Preferably, develop an Accessibility Testing team of persons experienced at using Assistive 
Technologies. 

• Microsoft Powerpoint also has a built-in accessibility feature. However, do not rely on 
‘machine’ testing alone to test for accessibility. 

• To access the Accessibility Checker in Microsoft Powerpoint: In the File tab, click on Info, 
Check for Issues, and then Check Accessibility.  

Creating Accessible Documents in Excel 
• Use named styles 
• Give all of your tabs a descriptive name 
• Remove any unnecessary blank cells 
• Specify clear and concise table headers 
• Add a title and axis labels to charts 
• Distinguish between lines with shape, texture and line types 
• Don’t use colours to distinguish cells 
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